# Table of contents

Table of contents ........................................................................................................................................... i

1. **Warranties & disclaims** ................................................................................................................................................. 1-1
   1.1 *Dantec Dynamics License Agreement* .............................................................................................................. 1-1
   1.1.1 Grant of License ............................................................................................................................................... 1-1
   1.1.2 Upgrades ....................................................................................................................................................... 1-1
   1.1.3 Copyright ...................................................................................................................................................... 1-1
   1.1.4 Limited Warranty ............................................................................................................................................ 1-1
   1.1.5 Limitation of Liability ....................................................................................................................................... 1-2
   1.1.6 Product Liability ............................................................................................................................................. 1-2
   1.1.7 Governing Law and Proper Forum ................................................................................................................ 1-2
   1.1.8 Questions ...................................................................................................................................................... 1-3
   1.2 *Laser safety* ....................................................................................................................................................... 1-3
   1.3 *CCD sensor warranty* ........................................................................................................................................ 1-3

2. **DC Image Acquisition System** .................................................................................................................................. 2-1
   2.1 *Overview* ....................................................................................................................................................... 2-1
   2.2 *Cameras supported by the DC Imaging System* ................................................................................................. 2-1
      2.2.1 *HiSense MkII camera* ................................................................................................................................... 2-1
      2.2.2 *FlowSense 2M camera* ................................................................................................................................... 2-2
      2.2.3 *HiSense 4M camera* ....................................................................................................................................... 2-2
   2.3 *Illumination systems* ........................................................................................................................................... 2-2
      2.3.1 *New wave solo pulsed lasers* ..................................................................................................................... 2-2
      2.3.2 *Shutter device* ............................................................................................................................................ 2-2

3. **Installation** ....................................................................................................................................................... 3-1
   3.1 *Unpacking the system* ........................................................................................................................................ 3-1
   3.2 *System installation* ........................................................................................................................................... 3-1
      3.2.1 Frame grabber(s) and synchronisation board Driver installation ............................................................. 3-1
      3.2.2 Frame grabber(s) and synchronisation board installation ........................................................................... 3-1
      3.2.3 Analog Input software and hardware installation ......................................................................................... 3-2
      3.2.4 DC Image Acquisition Software installation ............................................................................................... 3-2
      3.2.5 Uninstall the DC Image Acquisition software ............................................................................................ 3-2
   3.3 *Connections* ...................................................................................................................................................... 3-3
      3.3.1 Steps by steps procedure ............................................................................................................................... 3-3
      3.3.2 Connections diagram .................................................................................................................................. 3-4
      3.3.3 Analog Input ................................................................................................................................................... 3-4

4. **Using the DC Image Acquisition software** ........................................................................................................... 4-1
   4.1 *First time use* .................................................................................................................................................... 4-1
   4.2 *Online acquisition window* ............................................................................................................................. 4-1
      4.2.1 Tab: Acquisition Control ............................................................................................................................. 4-3
      Image acquisition .................................................................................................................................................. 4-4
      View control ....................................................................................................................................................... 4-6
      Storage control .................................................................................................................................................. 4-7
4.2.2 Tab: Timing Setup .............................................................................................................. 4-7
    Trigger control related parameters ..................................................................................... 4-7
4.2.3 Frame grabber settings (Tabs: FG1 Info and FG2 Info) ................................................... 4-8
4.2.4 A/D Setup ......................................................................................................................... 4-9
    A/D Setup control ............................................................................................................. 4-9
    Trigger settings ................................................................................................................. 4-10
    Channel 1 settings ........................................................................................................... 4-10
    Channel 2 settings ........................................................................................................... 4-10
4.2.5 Fail-safe function ........................................................................................................... 4-10

5. Troubleshooting ................................................................................................................... 5-1

6. Technical specifications ...................................................................................................... 6-1
1. Warranties & disclaims

1.1 Dantec Dynamics License Agreement

This License Agreement is concluded between you (either an individual or a corporate entity) and Dantec Dynamics A/S (“Dantec”). Please read all terms and conditions of this License Agreement before opening the disk package. When you break the seal of the software package and/or use the software enclosed, you agree to be bound by the terms of this License Agreement.

1.1.1 Grant of License

This License Agreement permits you to use one copy of the Dantec software product supplied to you (the “Software”) including documentation in written or electronic form. The Software is licensed for use on a single computer and/or electronic signal processor, and use on any additional computer and/or electronic signal processor requires the purchase of one or more additional License(s). The Software's component parts may not be separated for use on more than one computer or more than one electronic signal processor at any time. The primary user of the computer on which the Software is installed may also use the Software on a portable or home computer. This License is your proof of License to exercise the rights herein and must be retained by you. You may not rent or lease the Software.

1.1.2 Upgrades

This License Agreement shall apply to any and all upgrades, new releases, bug fixes, etc. of the Software which are supplied to you. Any such upgrade etc. may be used only in conjunction with the version of the Software you have already installed, unless such upgrade etc. replaces that former version in its entirety and such former version is destroyed.

1.1.3 Copyright

The Software (including text, illustrations and images incorporated into the Software) and all proprietary rights therein are owned by Dantec or Dantec’s suppliers, and are protected by the Danish Copyright Act and applicable international law. You may not reverse assemble, decompile, or otherwise modify the Software except to the extent specifically permitted by applicable law without the possibility of contractual waiver. You are not entitled to copy the Software or any part thereof. However you may either (a) make a copy of the Software solely for backup or archival purposes, or (b) transfer the Software to a single hard disk, provided you keep the original solely for backup purposes. You may not copy the User’s Guide accompanying the Software, nor print copies of any user documentation provided in “on-line” or electronic form, without Dantec’s prior written permission.

1.1.4 Limited Warranty

You are obliged to examine and test the Software immediately upon your receipt thereof. Until 30 days after delivery of the Software, Dantec will deliver a new copy of the Software if the medium on which the Software was supplied (e.g. a diskette or a CD-ROM) is not legible.
A defect in the Software shall be regarded as material only if it has an effect on the proper functioning of the Software as a whole, or if it prevents operation of the Software. If until 90 days after the delivery of the Software, it is established that there is a material defect in the Software, Dantec shall, at Dantec's discretion, either deliver a new version of the Software without the material defect, or remedy the defect free of charge or terminate this License Agreement and repay the License fee received against the return of the Software. In any of these events the parties shall have no further claims against each other. Dantec shall be entitled to remedy any defect by indicating procedures, methods or uses ("work-arounds") which result in the defect not having a significant effect on the use of the Software.

The Software was tested prior to delivery to you. However, software is inherently complex and the possibility remains that the Software contains bugs, defects and inexpediences which are not covered by the warranty set out immediately above. Such bugs etc. shall not constitute due ground for termination and shall not entitle you to any remedial action. Dantec will endeavour to correct all bugs etc. in subsequent releases of the Software.

The Software is licensed "as is" and without any warranty, obligation to take remedial action or the like thereof in the event of breach other than as stipulated above. It is therefore not warranted that the operation of the Software will be without interruptions, free of defects, or that defects can or will be remedied.

1.1.5 Limitation of Liability

Neither Dantec nor its distributors shall be liable for any indirect damages including without limitation loss of profits, or any incidental, special or other consequential damages, even if Dantec is informed of their possibility. In no event shall Dantec's total liability here under exceed the License fee paid by you for the Software.

1.1.6 Product Liability

Dantec shall be liable for injury to persons or damage to objects caused by the Software in accordance with those rules of the Danish Product Liability Act which cannot be contractually waived. Dantec disclaims any liability in excess thereof.

1.1.7 Governing Law and Proper Forum

This License Agreement shall be governed by and construed in accordance with Danish law. The sole and proper forum for the settlement of disputes here under shall be The Maritime and Commercial Court of Copenhagen (Sø- og Handelsretten i København).
1.1.8 Questions

Should you have any questions concerning this License Agreement, or should you have any questions relating to the installation or operation of the Software, please contact the authorised Dantec distributor serving your country. You can find a list of current Dantec distributors on our web site: www.dantecdynamics.com

Dantec Dynamics A/S
Tonsbakken 16 – 18
DK - 2740 Skovlunde
Denmark

Tel:  +45 44 57 80 00
Fax:  +45 44 57 80 01

Web site: http://www.dantecdynamics.com

1.2 Laser safety

To make for example PIV measurements often requires argon-ion or Nd:YAG lasers which are classified as Class 4 radiation hazards. This document is concerned with the DCPIV solution and there are NO direct instructions in this document regarding laser use and/or laser safety. Therefore, before connecting any laser system, you must consult the laser safety section of the laser and other illumination system components. Furthermore, you must investigate appropriate laser safety measures and follow local laser safety legislation.

Appropriate laser safety measures must be implemented when aligning and using lasers and illumination systems. You are therefore urged to follow the precautions below, which are general safety precautions to be observed by anyone working with illumination systems to be used with a laser. Again, before starting, it is recommended that you read the laser safety notices in all documents provided by the laser manufacturer and illumination system supplier and follow these as well as your local safety procedures.

It is also recommended that you use the following accessories when working with the Nd:YAG lasers

- Laser goggles
- Laser power meter

1.3 CCD sensor warranty

Direct or reflected radiation from Argon or Nd:YAG lasers can damage the CCD sensor of the camera. This may happen with or without power to the camera and with or without the lens mounted. Therefore when setting up and aligning for measurements, take extreme care to prevent this from happening.

Laser damage may turn up as white pixels in the vertical direction, or as isolated white pixels anywhere in the image. This shows up clearly when acquiring an image with the lens cap on.

The CCD manufacturer has identified all sensor defects into classes. Often the character and location of all defects are on record. Additional defects arising from laser-induced damage may void the sensor warranty.
Precautions

1. Cap the lens whenever the camera is not in use.

2. Cap the lens during set-up and alignment of the light sheet. Before removing the cap, make sure that reflections off the surface of any objects inside the light sheet do not hit the lens by observing where reflections go.

3. As general precautions to avoid eye damage, carefully shield any reflections so that they do not exit from the measurement area. You must wear appropriate laser safety goggles during laser alignment and operation.
2. DC Image Acquisition System

2.1 Overview

The DC Image Acquisition System comprises the FlowManager software with a special on-line image acquisition section. In the section, the acquisition system can be configured with the desired parameter settings and data can be acquired, pre-viewed and saved to disk at the operator needs.

A comprehensive number of data processing methods are available for analysing the data after the acquisition has been made and the data are saved to disk.

Note that the acquisition hardware used to control the camera and illumination system (typically a laser), hardware synchronisation and data acquisition/transfer must be installed in the same PC as the FlowManager software.

The system can be configured for either one channel (i.e. using one camera) or two channels (using two cameras of the same type). Currently, Dantec Dynamics’ HiSense MkII, HiSense 4M and FlowSense 2M cameras are supported, running in double frame mode only.

Trigger pulses are generated by the system, to be used to trigger a pulsed laser or a shutter device.

2.2 Cameras supported by the DC Imaging System

2.2.1 HiSense MkII camera

The HiSense MkII camera uses a highly performant progressive scan interline CCD chip, with typically 72% quantum efficiency at 532nm. This chip includes 1344 by 1024 light sensitive cells and an equal number of storage cells.

In cross-correlation mode (the only available mode with the DC Imaging System), the first laser pulse exposes the CCD, and the resulting charge is transferred as the first frame to the storage cells immediately after the laser pulse. The second laser pulse is then fired to expose the second frame. The storage cells now contain the first frame and the light sensitive cells the second. These two frames are then transferred sequentially to the digital outputs for acquisition and processing. The charges in the vertical storage cells are transferred up into a horizontal shift register, which is clocked out sequentially line by line through the CCD output port.

In relation to PIV and planar-LIF experiments, the Dantec HiSense MKII camera has a number of benefits compared to other cameras with:

- Very high light sensitivity (typically 72% quantum efficiency at 532nm)
- Extremely low background noise

The high dynamic range is a valuable flexibility in the practical performance of the PIV and LIF experiments (although most PIV experiments do not require 12 bit resolution, LIF does in terms of scalar resolution, precision and accuracy in some cases). Also, there is less need to adjust the laser power and the seeding, simply...
because a wider range of input intensity levels provide successful results. Likewise, if problematic windows, dirt or other produces uneven illumination over the area, there is less loss of local information, because the signal is still received at the CCD due to the higher dynamic range.

2.2.2 FlowSense 2M camera

The FlowSense 2M camera uses a high performance progressive scan interline CCD chip but with lower performance than the HiSense MkII camera (approx. 75% at 532nm and approx. 60% in the yellow-orange region of the light spectrum). Though, the chip includes a much larger number of storage cells with 1600 by 1186 light sensitive cells, which greatly limits the performance of LIF results in terms of precision of the scalar property measured. In relation to PIV experiments, the FlowSense 2M camera has the benefits to record in 8 or 10-bit data resolution, high light sensitivity at 532nm (about 75% of the HiSense MkII) and low background noise. The 8 or 10 bit dynamic range is a valuable flexibility in the practical performance of the experiment.

2.2.3 HiSense 4M camera

The HiSense 4M camera uses a high performance progressive scan interline CCD with a higher resolution than the HiSense MkII and FlowSense 2M cameras but lower sensitivity to green lights when operating in full-resolution mode (approx. 55-50% at 532nm and approx. 45-30% in the yellow-orange region of the light spectrum). Pixel binning (2x2) possibility is available as well to gain in sensitivity.

The camera resolution is 2048 by 2048 light sensitive cells and an equal number of storage cells. It runs with 12 bit resolution and re-sampled (upper) 8 bit resolution to gain space on the harddisk. (Note the latter settings do not enhance the framing rate.)

2.3 Illumination systems

Many methods of producing stroboscopic light-sheets are supported by the DC Imaging System; pulsed lasers, continuous wave lasers and electro-optical shutters are some typical examples.

Note: The DC Imaging System has the capability of supporting pulsed laser or a shutter device combined with a continuous laser system.

2.3.1 New wave solo pulsed lasers

The synchronisation part of the DC Imaging System controls the generation of trigger pulses. Two trigger pulses are generated for each laser cavity to fire a light pulse. (see Sections 3 & 4 of this document).

A fail-safe system is further built in to the software to secure the interlock will close in case of a system failure (see Section 4 of this manual).

2.3.2 Shutter device

Instead of a pulsed laser, a shutter device may be used. This shutter can be used together with a continuous wave laser and the trigger signals from the synchronisation part of the DC Imaging System can be employed to open the shutter (and keep it open for a specified period of time).
3. Installation

3.1 Unpacking the system

The DC Image Acquisition System comprises:

- 1 frame grabber for each camera package delivered with the DC System (also includes a CD-ROM with drivers installation software from National Instruments)
- 1 or 2 two cameras with power supply.
- 1 synchronisation board
- 1 timer box including a 1 m long connection cable for connecting to the synchronisation board, and 5 (10 m) cables for connecting to a laser
- 1 data interface cable (10 m) for each camera
- 1 trigger cable (10 m) for each camera
- 1 FlowMap CD-ROM with the installation software for FlowMap DC and FlowManager data analysis software

Note: The frame grabber(s) and the synchronisation board must be installed in the same computer as the FlowManager software. If the computer is part of the delivery the installation has already been done and do not require any further software installation. In this case you may go directly to section 4.4, otherwise please read carefully all Section 3 of this document.

Note: To use Dantec Dynamics’ DC Imaging System you need an illumination system, like a double cavity laser with lightsheet and optics.

3.2 System installation

Important note: Drivers for Frame Grabbers and Timer board must be installed before installing DC-Image Acquisition Software. Please follow the instructions provided below in the order of appearance.

3.2.1 Frame grabber(s) and synchronisation board Driver installation

Drivers for the frame grabbers can be found on the National Instruments CD-ROM included in the DC Imaging System Package.

These drivers are:

- **NI-IMAQ v2.6** - Driver for Frame grabber PCI-1428.
- **NI-DAQ v6.9.3** - Driver for PCI-660x Timer board

Note: These drivers must be installed before installing any hardware!
- Insert the NI-IMAQ CD and follow the instructions given by the installation software.
- Insert the NI-DAQ CD and follow the instructions given.

3.2.2 Frame grabber(s) and synchronisation board installation

Switch off the PC and install the PCI-1428 frame grabbers as described in the IMAQ User’s Manual. Install then the PCI-660x Timer board and refer to the DAQ User’s Manual if needed.
To make sure the boards are properly installed, start the MAX utility:

- Select “Start → Programs → National Instruments → Measurement & Automation (from Windows environment)”
- If you are prompted about ‘User preferences’, just click ‘OK’ to proceed
- In the Configuration part of this software (“View → Configuration”), select ‘Devices and Interfaces’. Among many PCI devices, the PCI-6601 device and 1 (or 2) IMAQ PCI-1428 devices should be present
- Click on PCI-6601: Device number should have the value 1
- Click on “Tools → IMAQ → Max number of buffer” and set the value to 1000
- Press the ‘Ok’ button
- Exit MAX utility software

### 3.2.3 Analog Input software and hardware installation

For installing an analog to digital board in your PC please refer to the manual and Driver Installation Guide enclosed with the board.

### 3.2.4 DC Image Acquisition Software installation

Software installation comprises installation of the DC software and device drivers for controls over the hardware used.

1. **Install FlowManager software package…**

   - Switch on the computer and insert the FlowMap CD-ROM delivered by Dantec Dynamics in the CD drive.
   - Select ‘Install FlowManager’ from the menu displayed, and follow the instructions given during installation.

2. **Install the DC Imaging System software and device drivers for the frame grabbers.**

   - From the FlowMap CD, select “Install DC-Imaging add-on” and click on “Install DC Imaging add-on”. This will install the device driver patch for the NI-IMAQ driver and additional files needed for the DC Image Acquisition software.
   - Reboot the PC

**Note:**

It is important that the version number of the FlowManager software matches the version number of the DC Imaging System software. If not, the installation will not succeed.

**Note:**

Note that when installing new software on your PC, you need to have administrative rights.

### 3.2.5 Uninstall the DC Image Acquisition software

If you need to run FlowManager software without support for the DC Image Acquisition software, please follow the next procedure:

- Select “Start → Settings → Control panel” and select “Add/Remove programs”
- Select “DC Image Acquisition” and click on the ‘Remove’ button.
- Select then FlowManager and click on “Change → Next → Repair → Next → Install” to repair FlowManager software
Now the DC part has been removed and FlowManager will operate as in the original installation.

3.3 Connections

3.3.1 Steps by steps procedure

Before utilisation of the DC system, all parts must be properly connected.

- Always turn off the power of the PC while hardware connections are made.

- On all cameras there is a DIP-switch. For the HiSense MKII/4M camera, verify that all four pins are in the lower position (i.e. ‘off’ position). For the FlowSense camera, all pins must be in the left position.

- Connect the camera Digital I/O connector to the frame grabber Camera link connector using the 10 meter data cable. The other connector on the frame grabber is not used.

- Connect the synchronisation board to the Timer Box using the 1m interface cable.

- Timer / laser box / camera(s) connections
  - Connect the connector marked ‘Out1’ on the Timer Box to the Camera Timing I/O connector (HiSense MKII or 4M) or DC In/Trig (FlowSense) using the 10 m trigger cable. If two cameras should be connected, use a BNC T-piece to connect both cameras to the Timer Box ‘Out1’ connector.
  - Using the 10 m long BNC cables, link the laser Flashlamp and Q-switch connectors to the timer box as follows:

        | Connection on Timer box | Laser cables          |
        |-------------------------|-----------------------|
        | Out2                    | Fire flashlamp 1      |
        | Out 3                   | Fire flashlamp 2      |
        | Out 4                   | (For shutter option)  |
        | Out 5                   | Fire Q-switch 1       |
        | Out 6                   | Fire Q-switch 2       |
        | Out 7                   | Not used              |
        | Out 8                   | Not used              |
        | In 1                    | Trigger input         |
        | In 2                    | Not used              |

        Figure 3-1: Connecting the interface cables to the Timer box

- Connect the camera power supply(ies) to the camera power connector(s) and to the 220/110V supply.

- Turn on the power for the camera(s) and the PC
3.3.2 Connections diagram

![Connections diagram]

*Figure 3-2: Overview on the DC Imaging System connections.*

3.3.3 Analog Input

The operator always needs to select a Trigger signal to initialise the A/D board and start data acquisition. Typically, the trigger signal that goes to the camera is used but any signal from the Timer box can be used as well.

When a signal is selected, connect a BNC wire from the BNC T-splitter to the external trigger input of the A/D board. Details on the use of the A/D software are reported in the sections below.

![Analog Input Diagram]

*Figure 3-3: Analogue/Digital board*
4. Using the DC Image Acquisition software

4.1 First time use

Every time the computer is booted, a utility software will initialise each frame grabber board installed. During this initialisation the following message is displayed. The message will remain for some seconds and longer time if 2 frame grabbers are installed.

![Utility software for initialisation of each frame grabber board](image1)

*Figure 4-1: Utility software for initialisation of each frame grabber board installed in the computer.*

- Start FlowManager software and select the correct device library.
  - This is found by selecting “File→Libraries→Device Library”.
  - Press “File→Open” and select DevLib440.fdl which contains the available devices. (When the default installation path for FlowManager is used, this file is found in the path C:\Program Files\Dantec Dynamics\FlowManager\Libs)

![Selecting the device library](image2)

*Figure 4-2: Selecting the device library.*

- Create a new database (“File→Database→New”) and a project with a new setup and add a HiSense MkII, HiSense 4M or FlowSense 2M camera and the laser source from the library. If the setup contains two cameras, add a second camera of the same type.

**Note:** The DC Image Acquisition System does not support mix of camera types; e.g. 1 FlowSense + 1 HiSense MkII. For multiple camera settings, the user shall select and use 2 identical cameras; i.e. either 2 FlowSense 2M, 2 HiSense MkII or 2 HiSense 4M.
Select “Options→System Unit Type” and Direct Computing Imaging.

Select the appropriate camera settings using FlowManager set-up functionalities.

Press then the green ‘Run online’ icon ( ) on the tool bar to enter the online acquisition part.

Figure 4-3: Selecting the appropriate camera settings using FlowManager set-up functionalities.

Figure 4-4: Selecting the DC System among the many acquisition systems available from Dantec Dynamics A/S.

Figure 4-5: FlowManager main window with iconised shortcuts to direct set-up and image acquisition start.
4.2 Online acquisition window

When the “Run online” icon (_runs icon_) is pressed, a new ‘DC Image Acquisition’ dialog box is displayed containing the following sections:

- Acquisition Control
- Timing Setup
- Frame grabber information (FG1 Info and FG2 Info when two cameras are installed) (see Figure 4.6).

Next to this dialog box a window displays images acquired during preview or while viewing images from temporary storage. If two cameras are installed (and set in the acquisition settings), images from each camera are displayed in separate windows.

**Note:** If only one camera is included in the setup but two frame grabbers/cameras are installed in the system, the software always use the camera connected to the first frame grabber detected (and this, even if it has been specified as camera number 2 in the setup).

![Image of the online acquisition window](image)

**Figure 4-6:** The online acquisition window with Acquisition control tab, Timing setup tab and camera Information tab(s)

4.2.1 Tab: Acquisition Control

The acquisition control tab includes all the functionality needed to control the acquisition process (either as preview or storage), the display of images from the intermediate storage as well as the process of saving the images to the FlowManager database environment.
Note that the system memory in the PC is used as temporary storage for the images acquired. Therefore to make the acquisition process more efficient in terms of maximum number of images, the system memory must be prepared for the data before the acquisition actually takes place. Also, depending on the amount of images to acquire this ‘initialisation process’ will take some time.

When the acquisition is started (by pressing the ‘Preview’ or ‘Initialise Acquire’ button), a message is displayed informing about memory initialisation. Once done, the button ‘Begin’ is enabled and when pressed, the acquisition begins with the settings described in the sections below.

**Note:** At the time of preparation, max. 90% of the available memory can be reserved for temporary storage, while the remaining 10% are reserved for the operating system.

### Image acquisition

![Acquisition control tab / Acquisition parameters](image)

**Figure 4-7: Acquisition control tab / Acquisition parameters**

- **“Records to acquire” & “Use full range”**
  To acquire a série of images, specify the number of records to acquire or check the option “Use full range” to record the maximum of records possible with the system used. (Note that 1 record refers to a double image from each camera.) Also, this maximum number of images is limited by the available memory in the PC. Below the “Initialize Acquire” button, a status line shows the storage capacity in terms of maximum records (and MBytes space). If the user enter say 250 records when the system only can store 150 images, the software automatically correct the value typed in the “Records to acquired” dialog and replaces it by the maximum available.

  Additionally, the total time the acquisition will take (in seconds) is given. The latter depends on the trigger frequency when the ‘Internal master clock’ triggering mode is used, and it is set to zero when the ‘External sync.’ mode is used (since the trigger frequency is not known.)

- **“Start laser” button**
  Pressing the “Start laser” button immediately starts the laser, which flashes at the Trigger frequency specified in the “Tab: Timing setup”. (Note that this is also a way to get the laser stabilised before record acquisition, which is a critical issue when e.g. running LIF experiments.)

  When the trigger mode is set to ‘External sync.’, the laser flashes each time the external trigger signal is received by the timer box.
Note: In any synchronisation case, no images are recorded until the “Show preview” or the “Initialize Acquire” buttons are pressed.

- **“Show preview” button**

The “Show preview” button offers the possibility to acquire images without saving the data in the memory. This is useful to ensure the system is set up properly for the wanted acquisition or for the focusing of camera(s) prior to image acquisition. Press the “Stop Acquisition” button to stop the continuous preview.

Note: When the “Show preview” button is pressed, the system memory is initialised and the synchronisation board runs on triggering the camera at the rate specified in the timing setup (i.e. fixed rate or externally triggered). The software transfers each double image from the camera(s) and display it in the image map window. At high trigger frequencies (i.e. approx. 2-3Hz for 1 camera system and approx. 1-2Hz for 2 cameras systems), overlap of images during updating the window may occur. This cosmetic display problem depends on the processing power of the PC and does not indicate at all technical problems with the image acquisition itself.

- **“Initialize & Acquire” button**

Once the number of images (and timing setup – see next section) are specified, acquisition can be done.

Press the “Start laser” button and then the “Initialize Acquire” button: the PC memory is initialised and when the system is ready the ‘Begin’ message is displayed (Figure 4.8b). Click on ‘OK’ to start the acquisition process (or on ‘Cancel’ to stop the acquisition process).

Note: If the “Start laser” button has not been pressed before the acquisition, a warning message is displayed asking to start the laser or cancel the operation (see Figure a below).

![Start Acquisition dialog box](image)

**Figure 4-8: Dialog boxes when starting measurements**

**Important tip:** It can take 30 seconds and more to initialise the memory, depending on the number of images to be recorded. During that period of time, if the “Start laser” has been pressed, the laser flashes.

For the safety of the operator, it may be adequate not to press the “Start laser” button. When the “Initialize Acquire” button is pressed without the laser flashing, a dialog box pops-up to inform the user to start the laser. That way, the laser flashes only during acquisition and not during the initialisation period.
The ‘Acquire images’ button now changes text and functionality to a ‘Stop Acquisition’ button. Acquisition will run until the specified number of images to acquire is reached or when the user presses the ‘Stop Acquisition’ button. Note that during the acquisition, a status line shows the progress and time left to finish acquisition process.

When the acquisition has ended, the records are stored temporarily in to the PC memory until the “Clear memory” button is pressed or on return to the main FlowManager software for the processing of the images.

- “Clear memory” button

This button is only enabled when at least 1 record is stored in the memory of the PC. When pressing this “Clear memory” button, all the data are removed from the temporary storage, which frees the memory to another complete range of records acquisition. This button must therefore be pressed when acquiring a new set of images; i.e. after a set of records is saved to the FlowManager database, or when the user is not content of the quality of the images recorded and thereby wishes to run a new acquisition, keeping the settings as defined.

View control

Once a number of records are acquired and stored in the memory of the PC, they can be browsed one by one, using the view control buttons. (Note that if only the “Show Preview” button is pressed there is no record in the system memory and therefore nothing to view.)

![View control](image.png)

*Figure 4-9: Records in PC memory can be browsed via the ‘View control’ feature of the DC Image Acquisition Software*

- Play buttons

Use the play buttons to view the next image in memory (>) or the previous image in memory (<). This option can use to check the quality of some of the records before they are transferred to the database.

- Fast play button

The Fast play button (>>) has a similar functionality as the Play buttons. Position the slider at the first image you want to see, press the Fast play button, and all subsequent records are shown at a rate of approx. 1Hz.

- Scrolling

Records can also be viewed by clicking with the mouse cursor on the scrolling bar and moving the mouse cursor towards the right (next record) or the left (previous record).
Storage control

To save the images stored in the PC memory to FlowManager database environment, specify which images to save, using the ‘From’ and ‘To’ input fields or check the ‘Save all’. Press then the “Save in database” button, which will start the transfer of the records selected from the system memory to the database and the harddisk. A status line will appear and show the progress and time left to finish the transfer process. If needed, the user may stop this transfer by pressing the “Stop transfer” button.

Figure 4-10: Storage control window.

4.2.2 Tab: Timing Setup

Select the ‘Timing Setup’ to specify the timing parameters to run during image acquisition (Figure 4.11). Note that it is important that the correct timing parameters are specified to achieve proper results.

Figure 4-11: Timing control window.

Trigger control related parameters

- Trigger mode

The DC Image Acquisition System allows both internal run (i.e. user-defined acquisition frequency) and external triggering. In the latter case, an external trigger source must be connected to the Timer Box ‘In1’ connector (see Figure 3-3).

  - When selecting the trigger mode 'Internal master clock’, the trigger pulses are generated by the synchronisation board at a rate specified in the ‘Trigger frequency’ field (between 0.25Hz and a camera dependent maximum rate)

  - When setting the trigger mode to 'External sync.', the trigger pulse generated by the external trigger source control the acquisition system. Note that the software makes sure that the camera is not triggered at a rate faster than maximum rate If the trigger pulses arrive faster than this frequency, only every N’th pulse triggers the measurement with N chosen so that the frame rate comes just below the maximum rate.

- Trigger frequency

The trigger frequency determines the rate (in Hertz, Hz) at which the camera is triggered to deliver double images. In ‘External sync.’ trigger mode, this field is disabled as the trigger frequency source determines this acquisition rate.
• Trigger delay

Note that this option is only available when the ‘External sync.’ trigger mode is selected. The ‘Trigger delay’ specifies the time necessary for the external trigger pulse to arrive so the laser fires (or the shutter is opened). Delays for the camera and laser/shutter are also taken into consideration. Due to these delays in camera and laser, the trigger delay must be above a minimum value. In case the specified value is below the minimum value, the software will automatically update this value and display the adequate message.

Note: With the present DC Image Acquisition System, the maximum trigger delay is 4 seconds.

• dt

The ‘dt’ is the time between the first and the second laser pulse. The first laser pulse is exposed in the first image (frame A) while the second laser pulse is exposed in the second image (frame B). The value of dt can vary in the range 5µsec to 80 msec. Naturally, the adequate value of ‘dt’ depends on the flow measured and camera set-up. Prior knowledge of expected velocities is typically very helpful.

4.2.3 Frame grabber settings (Tabs: FG1 Info and FG2 Info)

There are no settings to be applied for the frame grabber and the camera that are part of the system. The only information displayed is the grabber type, the serial number and the memory on the board. (Figure 4.7) with as many dialog windows as there are frame grabbers installed in the PC.

The frame grabber is automatically detected when installed and its parameters are matched with the settings of the camera.

Note: If the onboard memory is displayed as ‘N/A’, there may have been problems during the detection of the system. Rebooting the PC very often fix this problem.

Note: The camera(s) is(are) always set to double frame mode, full pixel resolution and 12 or 10 bit for the HiSense MkII/4M and FlowSense 2M, respectively. Note that no camera settings can be changed from the software.

Figure 4-12: Frame grabber information tabs
4.2.4 A/D Setup

If an analog to digital board is installed in the system, analog data can be acquired and saved as analog waveforms together with the images. Note there is not much difference from setting up an ordinary digital oscilloscope and to setup the DC-Imaging Analog input, as shown in the following:

The property page for the A/D Setup Tab can be seen in figure 4-13.

![Figure 4-13: Frame grabber information tabs](image)

**A/D Setup control**

- **Use analog input**
  When the analog input is not needed, disable the input by removing the check mark from the box ‘Use analog input’.

- **Max number of analog samples**
  Below the check box ‘Use analog input’, the maximum number of analogue samples appears. This number, which depends on the onboard memory size and the Sample delay/range setting, shows how many waveforms the board can hold.
When the user specifies a number of records that exceeds the max number of analog samples, only the first “max number of analog samples” will contain analog data.

- Sample delay/range (in the bottom of the dialog)
  This input has two functions:
  1. The user specifies the delay from the trigger to the analog values that are saved with image data.
  2. This setting specifies the length of the waveform in time. (The range is from 0.1 µs up to 1 ms.)

**Trigger settings**

- **Trigger select**
  The trigger input of the CompuScope board is ‘edge sensitive’. It is possible to specify if it is a positive edge or a negative edge that triggers the acquisition.

- **Level**
  Together with specifying the trigger polarity a voltage must be specified. (The range is from –5.0V to +5.0V.)

**Channel 1 settings**

- **Range**
  Specify here the input voltage range for channel A.

- **Coupling**
  This input is used to specify if the input coupling is DC or AC. Like on an ordinary oscilloscope, the user has the possibility to select or to remove any DC level offset by choosing AC.

- **Attenuation**
  Attenuation is related to the probe that is used. If the operator uses a x10 probe then attenuation x10 must be used, likewise for a x100 probe the attenuation is set to x100. When no probe are used, just connect the BNC cable from the signal source set the Attenuation to x1.

**Channel 2 settings**

- **Channel Enable**
  For some boards it is possible to disable channel B.

- **Range**
  *See Channel 1 settings.*

- **Coupling**
  *See Channel 1 settings.*

- **Attenuation**
  *See Channel 1 settings.*

### 4.2.5 Fail-safe function

For the safety of the user, a fail-safe function is included in the DC Image Acquisition software.
To enable this safety system, the Timer box (which contains a watchdog circuit) must be connected to the laser interlock. The watchdog functions as a relay that establishes a connection between the two pins in the cable labelled ‘Interlock’ when it is active. This circuit is always held active by the DC Image Acquisition Software and if/when the software crashes or when leaving the online acquisition section of the software it “breaks” the connection

**Important note:** If the software crash ends by sending an error report, the safety connection will not open until the user sends the report. Also if a ‘blue screen’ crash ends with memory dump, the connection will not open until the end of the dump.

**Note:** The cable from the ‘Laser’ connector on the Timer box, fits into the ‘Interlock’ connector of e.g. the New Wave Solo PIV laser provided with the DC Image Acquisition System. You can check that by entering the online acquisition part. The interlock then opens and it stays open until you return to the FlowManager main part again. If this is not the case, check that the connection between the Timer box and the laser interlock control is established.

**Note:** During the memory preparation, occasional closing and opening of the interlock may occur.
5. Troubleshooting

**Problem:** The very first time images are acquired after the camera is powered on, the frames A and B may be switched.

**Solution:** Stop the acquisition/preview, and the image sequence will be correct in the following acquisitions.

**Problem:** A timeout error is received

**Solution:** Turn off the power for the camera, and on again.

Problem: When using trigger mode External sync., the first image received may be exposed at a wrong moment (before or after the laser pulse)

**Solution:** If possible, begin the acquisition before the external trigger source is activated.

**Problem:** If you cannot select the DC System in the the emnu “Options→System Unit Type, it may be due to conflicts between the installed drivers and old drivers of the NI-IMAQ or NI-DAQ type.

**Solution:** Uninstall the DC software, the NI-DAQ driver and the NI-IMAQ driver. Repair the FlowManager software and install the DC Image Acquisition software and the NI_DAQ driver again.

**Problem:** You cannot change settings in the timing setup even if no data belong to the current setup.

**Solution:** Exit the online acquisition part and enter again. It can be because you have deleted images, which belong to the current setup while you were in the online acquisition part.

**Problem:** No image on either frame A or frame B

**Solution:** Check the cable connecting the Timer Box and the synchronisation board in the PC.
### 6. Technical specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of cameras</td>
<td>1 or 2</td>
</tr>
<tr>
<td>Image acquisition rate</td>
<td>Camera dependent</td>
</tr>
<tr>
<td>Camera supported</td>
<td>HiSense MkII, HiSense 4M, FlowSense 2M</td>
</tr>
<tr>
<td>Trigger mode</td>
<td>Internal timer or external trigger</td>
</tr>
<tr>
<td>Laser/shutter trigger</td>
<td>TTL level</td>
</tr>
<tr>
<td>Records to acquire</td>
<td>Depending on number of cameras and available system memory</td>
</tr>
<tr>
<td>System memory</td>
<td>Up to 2 GBytes (limited by the Windows operating system)</td>
</tr>
<tr>
<td>Operating system</td>
<td>Windows 2000/XP</td>
</tr>
</tbody>
</table>